Q"uemrwos
C@‘ p KJWV

Creating a
Dashboard in
Microsoft Excel

["0
o

‘

=datawise
—% LONDON A&

f\.



@ superh|ghwoys

hamessing technology for community benefit

Contents
L] o] LT U PO TSP UU PO PRRPRO 4
1. Make your data into @ table ..o.uiei i e sb e e s e nareeas 4
2. NAME thE tabI@ .ttt et e s e e st e b e e sne e e s b e e naras 4
PIVOT TABIES .ttt s bt sttt et e bt e s b e s bt e sab e et e e bt e b e e beeabeesateenteebeenbeesaeesane e 5
O O ¢ T Y i o == W o 11V i =1 o] TP 5
2. FIEI VAIUBS ..ottt ettt et s e s bt e e at e s b et e ab e st e e s bt e e s be e sbeeennreesreeenans 7
3. Sorting & Filtering @ PivOt table......coi i e st e e 8
4. Refreshing data in @ PIVOt 1able.........oo i e e e e e aaee e 9
5. RecommeNnded PIVOL TAbBIES .....cccuiiiiiiiieiieee ettt ettt st st sttt s ee e e s 9
6. PIVOL taDIE CNAItS ..o ettt sttt be e s st beenre e sheesnee e 10
WOrKiNg With PIVOT taBIES .....vviiiiiiiie ettt e et e e s st e e e e sbteeessbteeessbeeeessseeeeesnnes 11
7. Changing value field SETEINGS ....ccicuiiii i e e s e e s saba e e e s breeeenaaeeeeas 11
CUSTOM VAIUB NAIME ...ttt ettt e bt sh e st e et e e sbeesbeesaeesabeeabe e bt e beesbeesbeesaeeeaseenbeenbeesaeenas 12
SUMMATISE VAIUBS DY ...ttt e e et e e e et e e e s e bteeeeebteeesesaeeeeensteeesenssneesaseeeananses 12
SNOW VAIUBS AS ...ttt sttt ettt e s bt e s bt e sa e e s ab e e bt et e e be e bt e ebeesaeesateeaseenbeenbeesbeesanenas 13
T O F-Ta =4[ o = d o 1=l Yo T Ao o =T USSR 14
9. CUSEOM SOt OFTEN ..ttt ettt ettt ettt ettt e ettt e st e e bt e e s ab e e sabeeesabeesabeessbeesabeeebbeeanseesabeeesareesn 15
10. LG oYU T [gY = =1 T3S URRN 16
WOTKING WItN GRS ..o it e e e e et e e e e st te e e e e bteeeeeabeeeeeabtseeeanssaeeeasteeeeasesaesastanaesnnes 17
11. ANALOMY OF @ CHAI . e e e e e e s sata e e e esbbeeeesnsaeeeeaareeeeas 17
12. Creating PIVOL Charts ......cii et e e et ee e e e eabae e e e s beee e esabreeeenareeas 18
13. L0 T e [T T o PRSP 19
14. (0 =T o TN ol o T o 4] o 1SS 19
15. Chart ElEMENTES ...ttt ettt e bt s bt st e et e bt e bt e sbeesbeeeateenbeenbeesbeesaeenas 20
16. Hide Value field bUtton SETHINGS ....ciiiciiiiiecie e e e e e e 21
17. Changing the data SEIIES .....uiiii e e e et re e e e sba e e e e sabe e e e esabeeeeenareeas 22
Making ROWS/COIUMNS BIOAEN ........ooouviieiieeeeeeee ettt et et e et e e e ete e e eaveeeateeeeneeesreeenes 22
Make each data point @ different COIOUN........ooouiiiii e e et e e e e e e e 23
Creating an EXCel DashbOard.......... .t e e e s e e e e e e e st eee e e e e e e e ennrraaeeeaeeaanas 24
18. Preparing YoUr WOrKDOOK .........c.uuiiiiee ettt et e s abee e e s aae e e s e aba e e e earaeas 24
19. Formatting your DAashbOard ..........oeoiuiiiiiiciiie et e e e e bee e e s abe e e s e abae e e enraeas 24
7AYo [« I N1 =TT OO OO TSP UPT PP 24
Hide Gridlines, Headers & the fOrmMuUla Dar ...ttt ereneees 24
Nl 2

TR



Dy Superhighways

20. K] 1100 PSRNt 24
FOrMAtting @ SHCEI .ot e st e e e st e e e s e b be e e e s bbeeeesssbeeesesraaeessbeeessnnrenas 25
Linking the SlICEr t0 YOUI CRAIS .....oocuiiii e e et e e e st e e e et e e e e enba e e s e abaee e enrenas 26

Refreshing the DashDOArd...........oooiiiiiiciiiie et e e e e et e e et b e e e ssasaeeesaasaeeeenasaeeeennsrneeans 27

\\..I!,é 3

}ff‘. "\



@‘ superhighways

hamessing technology for community benefit

Tables

1. Make your data into a table

Page Layout Formulas Data Review View Help @ Tell me what you want to do

. + . =
1. Click on the Hi Get add-ins E 17
PivotTable Regs Ced Table Pictures inlne Insert tab & My Add-ins - Bing People Recommende
Pictures Maps Graph Charts
2. Click on the ustrations Add-ins
Table command Table (Ctrl+T)
button :
Create a table to organize and
analyze related data.
A | Tables make it easy to sort, filter, D E [ F [ G
1 |Name Y and format data within a sheet. genow Date registered Age at registration Instrument experience
2 |Alain Prost e Tell me more 05/04/2003 Guitar
3 _Alia Bhatt rrorrrarerary orergrorg-acarary 09/09/2016
4 |Andre Agassi HMP Swansea 14/12/1975 21/03/2003 Guitar

—> Alternative shortcut: Ctrl + T

Create Table ? *

Where is the data for your table?
=3A51:5M352|

|*

3. A window will open.
Confirm the cells to be
included in the table and that

Cancel the data has headers

My table has headers

2. Name the table

It is good practice to name the table as it makes life much easier later when working with formulas. Naming
the formula is basically giving your data set a name which will enable you to recognise which data set you
need to be working with.

Music Mentors data with notes - Excel

Data

Formulas Review A= Help Design

Home Insert

File

able Name: Summarize with PivotTable D Header Row ] First Column
>

[] Total Row [] Last Column
Banded Rows [ Bandad Columns

Page Layout

1. Click on the table & select
the Design tab

External Table Data Table Style Options EaE e

[rable2 [ Remove Duplicates

Insert  Export Refresh

[ Resize Table Slicer -

Properties

B5

2. Rename the table. For
example, “BookingData”

TR
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Pivot Tables

1. Creating a pivot table

AutoSave [.II:SH “) v (5' v ¥ Music Mentors data with notesxlsx a2 - Saving...

File Home Insert view View Help Table Design
E— 1. Click on the Insert tab
B ] ? di-H- n”ﬂu )
I 07 = K i)
PivotTable mmended lllustrations Recommended Maps PivotChart
i - Ja| '
o . (';J My Add-ins E Charts 'CD v |_ v v v
. X Add-ins Charts =
2. Click on Pivot Table
Ref ~ | Date of birth ~ | Gender ~ |Age now ~ | Date reg
2 | T Alain Prost AMP Manchester 09/06/1972 a7
3 | 2 Alia Bhatt HMP Holloway 02/02/1950 70
4 3 Andre Agassi HMP Swansea 14/04/1957 62
5 4 Ben Okri HMP Manchester 23/04/1984 35

AutoSave < Music Mentors data with not o Sav /O Search

Fle Home lnsert  Pegelayout Formulas  Data 2. Select the table you want to base the pivot table
Participants - ft | Dave Robson on. Here you can see the table name “participants”.
Ref [~ |Name il prison - Dateofbirth]  Using a table ensures you have a dynamic data source

2 1 Alain Prost HMP Manchester for your pivot table

3 2 Alia Bhatt HMP Holloway A
4 3 Andre Agassi HA 21/03/2003 rPIays a
5 4 Ben Okri HYj Create Pivotlable X1 09/09/2016 No mu
6 5 Boris Becker H_P Choose the data that you want to analyze, L 27/02/2017 E’|ay5 a
7 6|Dave Robson IHN @ Select a table or range | 21/03/2008 'No mu
8 7 David AttenborougHN — 17/08/1998 Plays a
9 8 David Beckham  H] Teble/Range: | Particganty 2T 31/01/2008 Plays a
10 9 Diane Kruger R Use an external data source B 21/03/2003'No mu
1 10 Diego Maradonna H_|‘ Choose Connection.. | 04/05/1999 'NO mu
12 11 Dilip Kumar HY Connection name: | 23/07/2013 No mu
13 12 Emma Barnett HY Use this workbook's Data Model L 17/08/1998 "No mu
4 13 Emmanuel Macron H) ) 19/02/2004'No mu

| Choose where you want the PivotTable re| v
15 14 Enid Blyton HA =! 3. Select New Worksheet 17/08/1998 Plays a
16 15 Fiona Bruce HY © bow Worksheet - 30/09/1999"No mu
7 16 Freya Crew g O Bristing Worksheet | 04/05/1999'No mu
8 17 Harper Lee HH Location: * | 04/04/2009 'Plays a
19 18 Hone Heke H_F Choose whether you want to analyze multiple tables L 09/09/20163:"3"5 a
PO 19 Jacina Ardern HA [ Add this data to the Data Model | 02/06/2000’P|ay5 a
P1 20 Jack Tate HY | 05/04/2003 Plays a
p2 21 Jane Goodall HY Cancel | 04/05/1999 'Plays a
P3 22 Jason Robinson HNir owansea ZIJUUITUL J0 04/05/1999 'PIays a
P4 23 Joan Chen HMP Bronzefield 16/02/1970 18/02/1900 17/08/1998 No mu
PS5 24 John Cleese HMP Pentonville 18/09/1963 25/02/1900 07/03/2011 "No mu
P6 25 John Steinbeck HMP Pentonville 28/06/1969 50 21/03/2003 'Plays a
urd 26 Jonny Wilkinson  HMP Swansea 05/06/1985 03/02/1900 05/04/2003 :Nc mu
Particpants | Sheet1 | Attendance | Service feedback | Outcomes | (3 1
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= X Cut .

P Search

Home Insert Pagelayout Formulas Data Review View Help  PivotTable Analyze  Design

= v 30 Wrap Text

B BB
Conditional Formatas Cell
Formatting ~ Table » Styles ~

General

@ % 9

@ copy ~

- g 0
~  <¥ Format Painter [l Merge & Center '}

W 0

clipboard alignment & Number [

Styles

To build a report, choose fields from the PivotTable Field List

4. An empty pivot
table is created

5. The columns from your
table appear in the fields

2

27
28

29|

Sheet1 Participants Attendance Service feedback Outcomes

Insert Delete Format

> AutoSum v
EFin~
& Clear~

Editing

&= =

Cells

PivotTable Fields
Choose fields to add to repart:
Search

[ Ref

[ Name

[ prison

[ Date of birth

[ Gender

[ Age now

[ Date registered
[J Musical experience

[ Instrument experience

Drag fields between areas below:

T Filters

Rows

Defer Layout Update

1 Share

L #

ind & Ideas

Select >

Ideas

Wi Columns

X Values

- Comments

sensitivity

-

6. To create a simple pivot table drag and
drop the field you want to organise you
into the Rows box and the Name field

AutoSave

File ~ Home Insert Pagelayout Formula

X cu ot Tn into Values

[ copy ~

<F Fomatpainter | © 1 Y v H¥ 2

Clipboard [ Font
A3 f Row Labels k

A B C D E F G H
1
2
3 |Row Labels '_Cnum'anlml
4 |HMP Bristol 5
5 ' HMP Bronzefield 9
6 |HMP Holloway 9
7 HMP Manchester 9
8 |HMP Pentonville B8
9 HMP Swansea 7 . H
S —— = 7. The pivot table now displays how
n . .
» many prisoners attended the music
13
L sessions from each prison
16
17
18
19
20
21
22
23
24
25
26
27
28
29
Sheet1 Pani(ipﬂnls Attendance Service feedback Qutcomes .\i"‘ 4

Alice Linell

# Share ™ Comments
g E @ﬁ 2 AutoSum ~
i % Fill ~
Insert  Delete Format Find & Ideas
- - - & Clear~ Select~
cells Editing ideas | sensitivity ~
L L . q
PivotTable Fields %
Choose fields to add to report: &~
Search fe
[ Ref -
¥ Name
[ Prison
1 Date of birth
[ Gender
1 Age now
1 Date ey
[ Musical expe
[ Instrument experience -
Drag fields between areas below:
T Filters 1l Columns
= Rows % Values
Prison = || count of Name -
Defer Layout Update

8. As the name field is text the pivot table
assumes you want to Count the number of
records in the Name
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P search

File  Home Insert Pagelayout Formulas Data Review View Help PivotTable Analyze Design 1 Share 11 Comments

[¥] Row Headers ] Banded Rows

Subils Gand | Report 840K | 51 o s ] B Coumns

05 . AL 9. Add complexity to your .

A B C D E F 1

: s Pivot table. To show how le Fields - x
2

3 CountofName Column labels [+ many of the attendees from T @
4 Prisons - No musical experience Notrecorded Plays a musical instrument Grand Total . D
5 [rnap risol : — s each prison already had

6 HMP Bronzefield 3 1 5 9 -
7 HMP Holloway 6 3 9 H H

e : . : . musical experience, add the

9 |HMP Pentonville 3 5 8 . . . h

10 HMP Swansea 3 1 3 7 field Musical experience to

11 Grand Total 20 3 24 a7

12 N

registered

" S

15 ! -
16

= Drag 1

18 T Filters Il Columns
;2 Musical experience -
21
22
23
24 = Rows I Values
25 Prison - Count of Name v
26
27
28
29 -

5 Musical experience | Parficipants | Attendance | Senvice feedback | Outcome: ... (& B v e

2. Field values

Numberical fields can be displayed in a number of ways in Pivot tables, for example you can display fields as
a percentage of the grand total.

Fle ~Home Inset Pagelayout Formulas Data Review View Help PivotTable & Share | T Comments
=] E@ Online Pict 3D Models ~ 1 1 1 Equation ~
B Onn Picures @ 30 Mol - | 1 1.Highlight the fields you want | & 1 | [ 4] Temeton
) Shapes ~ & SmartArt () symbol
Pictures $IMy Ad Recom} . Timeline Comment Text
5 icons @i Screenshot ~ &I My Add-ins ~ tO dISplay as a percentage =
Tables fustratins iters tinks | comments Symbels ~
B4 - £ |s -
A B C 1|J/KILIM[N/O|P|Q|R| |~ . .
1 PivotTable Fields X
2
: 5 v
3 T Choose fields to add to report: &
4 |HMP Bristol E calibi ~ 11 A A EE~% 9 E Search 0
5 [HMP Bronzefield ; BISO-A -0 -98
6 [HMP Holloway | 3 [ Ret -
7 |HMP Manchester -
8 |HMP Pentonville | [ copy v
- No Calculation
i
i
2 | swanses B somarcets %ot Gand Toa 2. Select Show Values As and
11 Grand Total Number Forma.. % of Column Total o,
2 then % of Grand Total
= [B getresh % of Row Total
14 Sort > % Of
15 =
16 X Remove “Count of Name' % of Parent Row Total
Drag fields between areas below:
7 Summarize Values By > % of Parent Column Total
18 <
19 Show Values As > % of Pargnt Total.. T Filters W Columns
;3 *Z Show Details Difference From...
22 [& value Field Settings. % Difference From
23 i
= PivotTable Options.. Running Total In = Rows = Values
= Bl Hice Fieig st % Running Total In... Prison + Il Count of Name S
26 Rank Smallest to Largest..
F1]
28 Rank Largest to Smallest
29 Index e
v Sheet2 | Sheet3 | Musical experience | Partic fe. @ i « v e LR
— More Opticns . . :
lect destination and pr; ENTER or choose Pasts erage 78 2 Counti 6 umc 47 = + 00%
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£ search
file ~ Home Insert Pagelayout Formulas Data Review View Help  PivotTable Analyze  Design & Share & Comments
i rﬁ - Caibi Jn A A = 2 Wiap Tt Percentage | B OB EBRE é:*l"‘j"'m iy O £
— = ‘
Paste . . AL = . ‘e 5 o0 tional Formatas Cell Insert Delete Format Sot& Find& | Ideas
v <F Format Painter ry QU-A = B Merge & Center B% Y WA, Table »  Styles + v v~ & Clear - Filter + Select v
Clipboard ] Font ] Alignment ] Number L] Cells Editing Ideas Sensitivity ~
B6 v ‘fl 19.1489361702128% A
A B C D E F G H
1] Voo
2
{ . {q} -
3 prions |- Count of Name 4. Use the Decrease decimal
4 |HMP Bristol 10.6% /O
5 |HMP Bronzefield 19.1%
& e oty [ o] place command button to B
7 |H0AP Manchester XY 3. Percentages
P [P — P round numbers.
9 _HMPSwansea 14.9% replace the
10 | {blank) 0.0%
11 Grand Total 100.00% Hp—.
0l original e
Welfare session attendee
13
| [ Date registered
z numbers 01 Musica experance :
6| )
"7 Drag fields between areas below:
18 T Filters I Columns
19
20
21
22|
23 -~
24. Rows I Values
25 Prison - Count of Name hd
26
27
28
29
v Sheet2 | Sheet3 | Musical experience | Parficipants | Attendance | Service fe .. F v e
B Om m - 1 + ou

3. Sorting & Filtering a pivot table

Simple sorting and filtering work exactly the same as elsewhere in Excel.

£ Search
File  Home Insert Pagelayout Formulas Data Review View Help PivotTable Analyze Design & Share & Comments
PivotTable Name: | Active Field: = = = o= B [ =] =) = =] [
e EE & 2 BEE (G = E O B
votlables fountoriame Insert  Insert Refresh Change Data | Clear Select Move | Fields, tems, Relationships | PivotChart Recommended | | Field  +/-  Field
[[@options ~ [[= Field Settings Slicer Timeline - Source ¥ - ~  PivotTable B Sets v PivotTables List Buttons Headers
PivotTable Adtive Field Group Filter Data Adtions Calculations Tools Show ~
A3 - Jr | Countof Name ~
A B c D E F G H 1 J K -1 .. .
1 PivotTable Fields > X
2
5 Choose fields to add to report: &~
4 |Prisons * No musical experience Not recorded Plays a musical instrument Grand Total ch p
2l sotatoz 1 4
z [ Ref -
SonZio A
Al s [ Name
More Sort Options, [+ Prison
[ Date of birth
[ Gender
Label Filters [ Age now
Value Filters [J Date registered

[ Musical experience
[] Instrument experience -

¥l (Select All)
~ HMP Bristol
~ HMP Bronzefield

% HWP Holloway Click next to the row or D ’

Drag fields between areas below:

Columns
¥ HMP Manchester
St column heading for sorting =
and filtering options s
= Rows Values

Cancel Prison - || countof Name -

27

29
Defer Layout Update

» Musical experience | Participants | Attendance Service feedback | Outcome:
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4. Refreshing data in a Pivot table

If you make changes to the data set being used to the pivot table, you might need to refresh the chart so
that the changes are immediately reflected in the chart.

AutoSave @ K) - Ql v ¥ Music Mentors data with notes & - Saved ~
File Home Insert Page Layout Formulas Data Review View Help PivotTable Analyze Design
PivotTable Name: | Active Field: . == = h [b. o3| o3 = =]
oz | | comcarn " | 4B & K B g N 1 0 fx;
[voriable ount of Name — . Insert  Insert Refresh Ciggnge Data Clear Select Move Fields, Items,
@Optioms v @Field Settings = | & Slicer Timeline ource ¥ z ~  PivotTable & Sets v
PivotTable Active Field Group Filter ata Actions Calc
B6 A Je 19.1489361702128%
A B C | D | E | F | G | H (1 J|K|L/M/N O P
T -
2 |
3 _Prisnns. v Countof calibri w11« AT AT =% 9
4 |HMP Bristol B I = Al
5 |HMP Bronzefield - - : )
6 |HMP Holloway 10%
7 |HMP Manchester [ copy
8 |HMP Pentonville Format Cells..
9 |HMP Swansea
10 | (blank) Number Format...
11 |Grand Total (
. [}':3 Refresh
12
13, Sort i3
14 |
15 X Remove "Count of Name”
16— Summarize Values By >
17 |
18 Show Values As >
19 *= Show Detail
20 = Show Details
217 | i# Value Field Settings...
22
23: PivotTable Options...
24| Hide Field List
25 |
26

5. Recommended Pivot Tables

A short cut to creating pivot tables can be to use the recommended Pivot table function.

AutoSave %] 3 - saved £ Search Alice Linell &

15 Share 2 Comments

Page Layout Formulas Data Review View Help

F @ Online Pictures €7 30 Models ~ B Get A s H]? di~ B~ M~ @ m d‘;‘@ E Iﬂ ]E ,§| @ @) lerj 4 | | TlEquation ~

O
= Shapes v @ SmartArt Ml B Symbol
ST th - i Maps PivotChart | 3D Line Column Win/ | Slicer Timeline ~ Link | Comment | Text Qs

Pictures Recommended ’
5 lcons ] sceenshor~ | 6IMy Add-ins « chars @~ ki~ Map - Loss -




6. Pivot table charts

File Home  Insert

Page Layou

PivotTable Name: | Active Field:

PivotTable2 Count of Name
[ options ~ [ Field Settings
pivolTable Active Field
D6 - S
A B
1
2

3 CountofName Column Labels
4 Row Labels
5 | HMP Bristol
& |HMP Bronzefield
7 |HMP Holloway
8 |HMP Manchester
9 |HMP Pentonville
10 HMP Swansea
11 Grand Total
12
13
4
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
Sheet1 | Participants

hamessing technology for community benefit

P search

t Formulas Data Review View Help

E = &

PivotTable Analyze

Design

2 Comments

1 Share

ERfeh=

B O @ G = [lig &

Insert  Insert Refresh Change Data Clear Select Move Fields, Items, Relationships ~ PivotChart Recommended Field +/- Field
Slicer Timeline v Source ~ v ~  PivotTable & Sets ¥ PivotTables List Buttons Headers
B PivotChart =
£ D E F G H | J .
. . & -
- 1. Click on the pivot table and
- No musical experience Not recorded Plays a musical instrument Grand Total /o
1 4 5 .
! N E— : then on the PivotChart E
6 3. 9
a . a ; command button
3 5
3 1 3 7
=
20 3 24 47
[ Date registered
[ Musical experience
[ instrument experience
[J Total hours -
Drag fields between areas below:
T Filters I Columns
Musical experience -
= Rows T Values
Prison - Count of Name -
Attendance | Service feedback | Outcomes | (&) v Defer Layout Update
B |- 1 +

2. Choose the chart type

Insert Chart

Recent
Templates
Column
Line

Pie

Bar

Area

XY (Scatter)
Map

Stock

IO
]
[
ad
®
E
WA
[t
@

Surface

Radar
Treemap
Sunburst
Histogram
Box & Whisker
Waterfall

Funnel

FiIESFOHRBREY

Combo

bl mR MR 'y a?

Clustered Column

| | | | | :"
RIRIRIRI
& & 2 J‘f

N

3. Choose the chart format

Cancel

=]

10
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Working with Pivot tables

7. Changing value field settings

In pivot tables you can select different types of setting for the values portion of your Pivot table. You can:

e Give the value set a custom (display) name
e Specify how you want to summarise values
e Specify how you want to display values

AutoSave B9~ Trainer - Data Essentials training data xlsx &2 - Saved Alice Linell (AL 5] - 1%
File Home Insert Draw Page L = L L — by = o e WotTable Analyze Design £ Share  Comments
A ; . A . . nsert v Z- Ao /O & s
| o | & 1. Right mouse click on the Value eg wete | [~ Q
Paste B I U o 0 Find & Ideas Share Webex
= u-. [He v . . o . . »
< Sum of Client ID and select the option [ Select This Fle
Clipboard & Font . . Cells Editing Ideas Sensitivity Webex ~
. Value Field Settings
B3 . S| su -
A B © L q 1
3 PivotTable Fields v %
2 Choose fields to add to report: @ ~
3 |Row Labels - |Sum of Client ID
4 #2019 3003 ISearch Jo
5 #2020 1183
6 Grand Total 4186 [ client 1D
7 [ Job Title
8 [ Organisation
9 =
j‘? @g fields between areasbe ¥ Move to Report Filter
12 Il Move to Row Labels
13 = Move to Column Labels
14
15
16 X Remove Field
17 = Rows @ Value Field Settings
18 Years -~ |Sum of Client ID: -
19
Quarters >
20 e
21
“ ... | Organisation - Pivot | Sheet9 | BookingData | Session Guidelines ® 4 » Defer Layout Update
I7.

11




Custom value name

File Home Insert Draw Page Layout Formulas Data Review View Help Power,

< X A & conditional For . .
A A ===1% 2
pL[] . o35 rmanme| TYPEinthe name you would like to
aste
B I & A =S==== A . X
- & R B cel syl use for the value field.
Clipboard 1% Font Alignment Number Styles ~
B3 Sum of Client ID
A B C D E F G H I . .
= O PivotTable Fields vox
2 Choose fields to add to repart: & -
3 |Row Labels - |Sum of Client ID |
4 =2019 3003 Value Field Settings -, o
5 42020 1183 : e
6 Grand Total 4186 R Client ID -
Mame:  Sum of Clien
7 Custom Name [ Job Title
8 Summarize Values By = Show Values As [ Organisation -
9 L. b—
Summarize value field by
1o R Drag fields between areas below:
11 Choose the type of calculation that you want to use to summarize
! I
12 ma from the selected field Y Fifters 1l Columns
13 7
Count
14 Average
15 Max
16 ;’:—g‘dud L
17 = Rows Z Values
18 Years ~ |21 || Sum of Client ID -
19 MNumber Format Cancel Quarters v
20 y h
21
"4 ...| Organisation - Pivot | Sheetd | BookingData | Session Guidelines ® ‘ 5 L
Summarise values by
P Search
File Home Insert Draw Page Layout Formulas Data Review View Help Power Pivot PivotTable Analyze Design 1 Comments
e, R iti ing € - v —
L['] & AAN|=E==% ' [ conditional Formatting R insert b A /O g O .
Iy~ FYRPR T T ) el [ L.
Paste P B L . A === —= Find & Ideas Share  Webex
L2 . Select ¥ This File  ~
Clipboard 1% Font Alignment 1. SeIeCt the ta b Summarise Values g ideas | Sensitivity Webex ~
B3 - Jr | Sum of Client ID Bv
A B C D E F I J K L 7 2
= O PivotTable Fields vox
z Choose fields to add to report: @ i
3 |Row Labels - |Sum of Client ID |
4 +£2019 3003 Value Field Settings, ? X | - e
3@ zu:u 0 1183 Source Name: ~ Cli
6 Grand Total 4186 . -
= Custom Nome: At Clantio 2. Select how you want your field
: Summarize Values By | Show Values As summarised -
ho Summarize value field by
hi Choose the type of calculation that you want to use to summarize
ha data from the selected field Y Fifters 1l Columns
13 7
Count
14 Average
ns Max
he Min
Prod v
h7 = = Rows % Values
e Years > 21| Sum of Client ID -
e Number Format Quarters -
po h
1
[« ...| Organisation - Pivot | Sheetd | BaokingData | Session Guidelines ® ‘ 5 L

12
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Most common calculations used to summarise data:

Function Summarizes

Sum The sum of the values adds all the values in the selected data range. This is the default
function for numeric values.

Count The number of values. The Count summary function works the same as the COUNTA
worksheet function. Count is the default function for values other than numbers.

Average The average of the values. The average is the mean average of the numbers. To
calculate: Excel adds up all the numbers, then divides by how many numbers there
are. In other words it is the sum divided by the count.

Max The largest value.

Min The smallest value.

Product The product of the values. The product is the result of multiplying the numbers eg the
product of 2 and 3 is 6.

Show values As

O Search

File Home Insert Draw Page Layout Formulas Data Review View Help Power Pivot PivotTable Analyze Design O Comments
n Y ercentage [Ef conditional Formatting ~ | @ Insert ~ >~ A? O
=, Z
B2 % 9 | HEFormatas Table v B Delete ~ | [T]v
- = Sort & Find & Ideas Share Webex
1. Select the tab Show Values As % - BB cell siyles « BElFomat v | €~ Fiter v Select ~ ThisFle ~
Number Styles Cells Editing Ideas Sensitivity Webex ~
A B © D G H I J K L M q 1
1 \ PivotTable Fields %
2
- Choose fields to add to report: & -
3 Row Labels - Client ID Value Field Se ? X
o | #2019 84.62%, Source Name: Client | Search £
5 | #2020 15.38% -
6 GrandTotal  100.00% G s | [ Client ID -
v Summarize Values By | Show Values As | [ Job Title
9 ) ow values as =
o | 3.Change the ofCotomn Tora 2. Select how you want to display the
11  field: Base item:
iz | number format T : data "
=
14
=
16
17 = Rows Z Values
18 Number Format Cancel Years v Client ID -
19
o Quarters T Iv
21
[ .| Organisation - Pivot = Sheet9 | BookingData = Session Guidelines @ 4 v P e

Most common ways of displaying data:

Use this
calculation
No calculation

To

Turn off custom calculation.

% of Column
Total

Display all the values in each column or series as a percentage of the total for
the column or series.

% of Row Total

Display the value in each row or category as a percentage of the total for the
row or category.

}/" 7 "\
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Rank smallest  Display the rank of selected values in a specific field, listing the smallest item in

to largest the field as 1, and each larger value with a higher rank value. Create a new
column for Rank if you want to show the specific amounts too.

Rank largest to Display the rank of selected values in a specific field, listing the largest item in

smallest the field as 1, and each smaller value with a higher rank value. Create a new
column for Rank if you want to show the specific amounts too.

8. Changing the sort order

DataEssentialsALLDATA-02Mar2020 - Excel PivotTable Tools

Insert Page Layout Formulas Data Review View Help Analyze Design @ Tell me w

- % - 2 T = = ab —
D Calibri (11 -[A A == #- €. Wrap Text General M E3|
Ep - i |

Paste " B I U~ = == €53 [ Mergescenter - 55 - 9% 0 5) 0 <R 1EnE B

M Formatting = Ta
Clipboard Fant I Alignment I MNumber I Style
B10 &2 || 2

1.Right mouse click on a
A B C . | H | | ] | K |

; value in the data set you
2 | want to sort
3 |Row Labels |-T|Countof CustomerID
4 |Email 19
5 |Internet 1
6 |Internet search Heard via?
7 |MNewsletter Calibri =11 | & A2 -0 s &
& |Twitter =

. B I = O~ A-
9 |Unknown —
10 |word of Mouth | : ~el Yninovin 2. Select sort and the sort a2

a@ Qop” .

Wl 2 i ) order you require
12 Format Cells...
13_ Mumber Format...
14_ ré Refresh
15
16 | Sort » 2| SortSmallest to Largest
1?_ 7<  Remove "Count of Customer ID" £l Sort Largest to Smallest
18 | Summarize Values By 4 More Sort Options...
19— Show Values As 3
20 B
21: *=  Show Details
22 [ Value Field Settings.. More sort options allows
23 o ione . cp

i PivotTable Options.. you to input a specific sort

L] | S DE SH Client |_D Hide Field List

Daars

order

14
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9. Custom sort order

Go to File > Options > Advanced

Excel Options ? *
General Allow user-defined XLL functions te run on a compute cluster & [+]
Farmulas Cluster type: A Options,,

Pata When calculating this workbook: | K Online Feedback A... ~
Proofin
d Update links to other decuments
Save [ Set precision as displayed
Language [ Use 1904 date system
Ease of Access Save external link values

Customize Ribbon

[ Ignare gther applications that use Dynamic Data Exchange (D

Quick Access Toolbar Ask to update automatic links 1. Selectthe Optlon Edit
Add-ins ] show add-in user interface errors Custom Lists
Scale content for A4 or 8.5 x 11" paper sizes

Trust Center

At startup, open all files in: | 7 -

Web Ogtions...

Enable multi-threaded processing

Create lists for use in sorts and fill sequences: | Edit Custom Lists...

Lotus compatibility

Microsoft Excel menu key:

[ Transition navigation keys

Lotus compatibility Settings for: | ﬁ Sheetl A

] Transitien fermula evaluation

[] Transitien fermula entry

[4]

0K | | Cancel

15




@)‘ superhighways

hamessing technology for community benefit

Customn Lists ? >

Custom Lists

Custom lists: List entries:

NEW LIST I'love this idea, This is an OK Add
Mon, Tue, Wed, Thu, Fri, 5at, & idea, | don't think this is a

Monday, Tuesday, Wednesday good idea, Nntsure| Delete

Jan, Feb, Mar, Apr, May, Jun, I

January, February, March, Apri \

/ 3. Clickon Add
4. Add your custom sort
order separated by
Pre commas.
Imp + Import
2. Click on OK

You can also choose to import the values from a range of cells.

10. Grouping dates

In Excel 2016 forward Excel automatically groups dates by months & quarters. If you are working with an
Excel version prior to that or you want to change the automatic grouping you can manually group dates.

%at Calibri . . # | Normal Bad Gaod Neutral = Bx [§ = autosum - “V p
mom 1. Right mouse click on o [Crcaatior ] (ST corctor . toloweatiy., || e oee e | B sots e
* Format Painter D e — v 5 - = Clear Filter = Select ~
Clipboard a d ate value Shyles Ccetls Editing
n
A N a P =] R H T u v w ala .
1 PivotTable Fields ~ %
E -
3 | Lnbels =] Count of Cust Choose fieldsto add to report: | 4%
= Grouping 7 x Searth g
s cam ”
& Nowv 38 VD
E Dec » PAstartingat 180200 e
8 -2020 32 EdEndingat | 270272000 . -
5| Zam » . 2. Select the Grouping
10 Jan 18 —y
n Feb 14 Mmmu H
12 Grand Total 109 DHS you req ulre
13
. =
15 L |
16 Number of dwg [1_
17
i =] e
19
20
2 Drag fields between areas below:

16
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d©

Working with Charts

11. Anatomy of a chart

Chart title
vertical

Secondary
Primary &
Gridline axis
vertical ABC Ltd /

axis A"
70.00%
\ Data labels
\ 60
- —— Axis title
SO.00%
Axis title
20.00% 2 sl
e (05t '.‘.ﬂd
30.00% ool
20000% —RO
........ Unear m*“
10.00%
C.00%

Primary Horizontal axis

Dl 17
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12. Creating Pivot charts

DataEssentialsALLDATA-02Mar2020 - Excel PivotTable Tools

Page Layout Formulas Data Review View Help Analyze Cesign

. n m-l2-- F n
L H Get add-ins 1?7 " |I- i @ |
) - LR US| | [ TR (N
lNustrations ) Recommended Maps PivotChart
3 iy add-ins - . [ - P
- oF MY Charts DL - -
Tables Add-ins Charts [
1.Click on the Pivot table you 15 ek _ h
want to make into a chart 2. Click on Pivot Chart
© | D | E | | 1
1 —
2 —
3 |Row Labels |T Countof Customer ID
4 : Internet 1
5 |Internet search 1
6 (Twitter 2
7 |Newsletter 151
8 | Email 19
& |Word of Mouth 29
10 |Unknown 42
11 |Grand Total 109 u
3. Choose the chart type
Insert Chart V ? X
{All Charts

Recent
wwoe (B A IR o ed
Column

Line Clustered Column
Pie
Bar . \
Area ‘ at
XY (Scatter) ‘ | | | || | || o
AR I |
J‘>:

4. Choose the chart format

Map 2 '\F,, o Afs« ¥
Stock M
Surface

Radar

Treemap

Sunburst

Histogram

Box & Whisker
Waterfall

Funnel

FIEZF@ERWEWRNSWeOREEDOS

Combo

18

}/" 7 "\



<2 superhighways
% pemnignway

hamessing technology for community benefit

13.Chart design

2 - DataEssentialsALLDATA-02Mar2020 - Excel t Alice Linell cal
File Home Insert Page Layout Formulas Data Review View Help Analyze Format Tell me what you want to do
0 — — 73z

(LA = = L = G{ oMl
Add Chart Quick  Change —tl L Switch Rowy Select Change Move
Element ~ Layout~ Colors =l 0 Column Data  Chart Type = Chart

Chart Layouts Chart Styles Data Type Location
Chart1 & F

A B c D E F G | H |1 K | L | M | N o : )

1 PivotChart Fields
2

1 Chi fields to add t rt:
3 |Row Labels |IY| stomer ID fosefisies fo addta repa
S . fsearcn |
5 |Internet searcl 1
6 |Twitter 2 Heard via? [ Session date
7 |Newsletter 15 [ status
ool 1 L frorn?
9 |w rd via?
oudl Change the colour palette ,

)| Un| I 2 Select the Chart Style port/ access neseds
11 Gr. ledge level
12 Email I 15 ]
13
Tl Newsteter N 15 Drag fields between areas below:
15 Twitter [ 2 T Filters Il Legen
16|
17] Internet search | 1
13 | Internet [ 1
19] = Axis (Categori.. | = Value
20

— Heard via? w7 Count of]
21
22

DataEssentialsALLDATA-02Mar2020 - Excel Alice Linell cal
File Home Insert Page Layout Formulas Data Review View Help Format Q Tell me what you want to do
i E s = = = - =
+ . — T . il
Add Chart Quick  Change =i 11l Switch Rowy Select Change Move
Element - Layout~ Celors -l oot . . Column Data  Chart Type  Chart
Chart Layouts Chart Styles Data Type  Locatien
Chart 1 - F
A | B ¢ | b | E | F | 6 | H | 1 | 1 |k L M N o
1] Chart Fields
2
o fields to add t rt
3 |Row Labels \IY\CountofCustomerlD M
4 |Internet 1
5 |Internet search 1 o
6 |Twitter 2 Heard via? Session date
7 |Newsletter 15 Status
8 |Email 19
2 Unknow | 2 Al
g |word of Mouth 29 Heard via?
10 |unknown a2 Weord of Mouth I 2o aort / access neeeds
11 |Grand Total 109 edge level
Email I 1o
12| Change the chart type i
13
7 Newslener NG 15 between areas below:
15 Twiteer [ 2 T Filters Il Legen
16
17] Internet search ] 1
18 | Internet ] 1
19 5 = Axis (Categori.. | £ Value:
20
— Heard via? < Count of]
21
22

19




15.Chart elements

ic Mentors data for Excel Sorting & Analys... &

- Saving P search

Alice Linell

File Home Insert Pagelayout Formulas Data Review View Help Chart Design Format
4 Qut 14 Ar | ===|%® ay . 2 7Y p
o Dmcopy . P Click on the + symbol to reveal the chart = o
-8 L= = & Clear v Select v
s s €lements. (De)select to add and remove g
Chart2 - £ chart elements
A | B L e | D | E | o | P | a | R
1 I have been able 10 build a positive relationship with a music mentor:
2 | Strongly agree Agree Neither Disagree Strongly disagree
3 HMP Holloway 10 6 4 6 3
4 HMP Bristol 7 7 3 2 1
5 |HMP Pentonville 18 8 1 1 1
6 |HMP Bronzefield 1 14 4 2 0
7 |HMP Manchester 9 16 5 3 2 o]
8 HMP Swansea 12 2 ] ] 0 Chart Title Chart Elements
9 — 20 © °
10| 18 © o
11 16 e o
12| 14 e ° [] Data Labels
13 | 2e e [] Data Table
14 we @ [ Error Bars
— 8 e e
15, [ o
16 ‘o I I .
17 20 o
] i ([ | [T A [ [
19 HMP Holloway HMP Bristol HMP HVP HMP  HMP Swansea
| pentonville  Bronzefield ~Manchester
20
21| mStrongly agree  MAgree M Neither m Disagree M Strongly disagree
2| [}
23

//
Different Chart Elements options will
appear depending on the type of chart

Data Essentials [Res

Gnly] - Excel Alice Linell 1 =]

Data  Review View Help  Analyze D @ Tell me what you want to do £ Share|
b CalibrifBody) |3~ K A = Narmal Bad hoC r'.- £ p
B3 copy - ol
P : CheckcCell | Insert _Delete Format Find &
" Fromaranr |5 T Y nsert_Delete Format | , s
Clipboord Font Aiignment Number Editing
@) READ-ONIY Wi opened this workbook reac-anky from the server, |t Workbaok CIle on the arrow next to the
Chart 1 - £~
; 3 c D : : c 5 chart element to reveal a drop-
1 Format Data Labels ~ |
: d f opti S
3 Row Labels -7 Count of Customer ID pi own menu o 0pt|0ns Label Options Text Options
S e o <N o OO E
5 Yes 67 Res
& Grand Total 109 Remove 3l [ Sinane . A
; O] Full Name Label Contains
s = ::, ;"' Value From Cells
i [ Organisation Series Name
il o o IS first Course with Superhighor... T e e
12 New to Superhighways? Income lvan
L [ ChanTiie ) Post code
iz S| 2 ovstetabes < comer 1) oreugh Percentage
15 [ Legend B [ Borough code /| Show Leader Lines
18 S I Countey .
12 Outside End Organisation Service Defivery type i
i 0 BestFit [ coune Tpe _ Sparator -
12 Data Callout B Reset Label Text
B More Options... |Preg fiekds between areas below: Label Pesition
;; T Filters W Legend (Series) * Center
23 Inside End
i Outside End
25 & Best Fit
2 -
z . © Momber
s Drill down to
29 = _Auis (Categon I Values

select more
options

20
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16. Hide Value field button settings

DataEssentialsALLDATA-02Mar2020 - Excel

Insert Page Layout Formulas Data Review  View Help @ Tell me what you want to do

&% Calibri M AN == 2 wrap Text General - '-': Z I:‘} L

By - o rY &

. B I U- === 3= Merge & Center ~ =0« % » 55 8 Cond|t|9na| Format as  Cell Insdg

Formatting ~ Table = Styles - ~
Clipboard 1« Font ] Alignment fa MNumber fa Styles
Chart1 & I
A 1] B 1] C 1] D 1] E 1] F 1] G 1] H 1] 1 J 1] K 1] L
1 —
2 —
3 Row Labels - | Count of Customer ID
4_
. . e
5 1. Click on a value field e - ?
6 .
= button in the chart
cl
9_
10|
1) T  Move to Report Filter Knowledge level v
:;— £ Move to Axis Fields (Categories) W Alittle knowiedge o
1 Il Move to Legend Fields (Series) ¥ Gaod knowledge
= 2. Select hide the = Noknowiedge
| - - Some knowled
16 | selected button or Hide Value Field Buttons on Chart ome Knawiedes
:;_ hide all Hide All Field Buttons on Chart
u X Remove Field

19| o}
20| I——‘O Value Field Settings...
21

21




17.Changing the data series

Making Rows/columns broader

&)
\“‘?/4\4

%

1 i
% superhighways
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AutoSave @ [E:“'E Q‘ v ¥ Attendee data completed- Creati” Alice Linell ({4
File Home Insert Page Layout Formulas Data  Review 2.The rt Analyze  Design  Format 5 Share =
Series "Total" - \\ F\ Format =1 |Ic:-I= e D
() . =g i
& Format Selection Ooql~ ~ Abc Abc Abc window & 3
(?lzl Reset to Match Style /_\. T L= W|” open Selection Pane | =
Current Selection Insert Shapes Shape Styles Arrange Size & ~
Chart1 - f =SERIES{Boroughs!SBS3,Boroughs!SAS4:5A532,Boroughs!SBS4:5B532,1) €5
A | B Cc | D | E | F | - .
1] Format Data Series ~ X
2 } .
3 |Row Labels -7 Count of Customer ID o) 0 re) Series Options */
4 |Barnet 3 ' +
—| westminster [l 2 & C’ III
5— Brent 8 Wandsworth x 2
6 |Bromley 3 Waltham Forest ] 1 ol 4 Seri i
7 |camden 5 Series Options
7 Tower Hamlets i 1 .
8 |City of London 1 suton [ 5 Plot Series On
9 | Crolydon " Southwark 13 Primary Axis
10 |Ealing 1 Richmond 4 -
1 1, Enfield 4 Not Applicable [l 2 seondan e
12 |Hackney 5 Newham H 3 Series Qverlap t 0% ;
13 |Hammersmith & Fulham 2 merton [l 2 ) -
| Gap Width = 42% .
14 |Harrow 1 Lewisham _ s
15 |Havering 2 Lambeth [ ©
16 |Highbury and Islington 2 Kingston N
17 |Hounslow 1 Islington % 4
18 | Is.lington 4 ] Hounslow JJ 1
19 Kingston 2 Highbury and.‘.! 2
20 |Lambeth 9 Ha
21 |Lewisham 8
22 |Merton 2 wmmers] 3. Change the Gap
23 Newham 3 . .
24 | Not Applicable 3 "l width to increase the
25 Djahmand 4 width of the bars
26 . 13 c
1. Click on the data 5 city of tongen T T
. . . 1 Camden H 5
series (in this 1 bl — Do
instance the bars in 2 Brent # 5
Barnet 3
the chart) to select =
S

4
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Make each data point a different colour

Autosave (XD B 9-

2. In the format

ating a Dashboard £ - Saving... ¥

TORS

Alice Linell |14

0

.
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File Home Insert Page L{ . . View Help PivotChart Analyze Design Format = Share 12
A_ window click on - - -z
. . T v ZV¥ ~ /"7
PE@EBV T the Fill & Line - . m o v
- & | @ &+ 2| command button [Erormat | @~
Clipboard 5] Font Styles Cells Editing Ideas Sensitivity
Chart 1 - fr | =SERIES(Sheet2!$B53,5heet21SAS4:5A58,9
1. Click on the data series S E | - :
: Format Data Series  ~ X
(in this instance the N| seres Opeins +
columns in the chart) to
. < Bl |
select it.
K 4 Fill
s_mrm—‘ No fill
9 | o
10 Solid fill
1 1: Gradient fill
12_ Picture or texture fill
13 [o; )
14_ i Count of r 1D - + Pattern fil
15, ®) Automatic
16: Total & Invert if negative
17 | S0 | Vary colors by point
18 | 80
19 70 .
20: 60 W Frontline e 2
217 50 m Infrastructure Border
22 40 )
2 | 30 Public
23
24_ 20 l unknown /
= 10
25 (
= 0 o—0 B==0
gg_ Frontline Infrastructure Public unknown 3 CheCk the Vary
= e R T Colours by point option

J
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Creating an Excel Dashboard

18. Preparing your Workbook

Create worksheets in your workbook as follows:

1. Data

2. Analysis
You can create these as you begin to work on the data. Ideally create one worksheet for each pivot
table.

3. Dashboard

1 2 3
15 | 14 CEO Citizens Advice Richmond Yes TW12 1NY Richmond Frontline Open Data EsseiHive
16 | 15 You e Pec Community Action Sutton No SM1 3AA Sutton Infrastruci Open Data EssetHive
A= - ¥ ¥ ¥ T ¥ P— rs O e
» ‘ Dashboard 1 Borough - Pivot ‘ Knowledge - Pivot Heard via - Pivot | Organisation - Pivotl Data |... &

19. Formatting your Dashboard

Add Title
Add a text box to add a title to your chart

Copy and paste charts in from other sheets, hold Alt key down when moving to snap charts to the gridlines

Hide Gridlines, Headers & the formula bar

Alica Linell | §

AutoSave B Y-

On the view tab, check/uncheck

File Home Insert Page Layout Formulas Data Review
fo—] :

@ @ I e BeD Sheet elements you wish to
Normal Page Break Page . . Zoom 100% Zoom 10 y ShOW/hIde

Preview Layout L] Gridlines Headinos Selection | Window  All PaL

Workbook Views Show Zoom Window Macros
5 .
> . —— -
10 Hackney NN 5
11 Hammersmith & Fulham [l 2 Frontline Infrastructure
12 Harrow [l 1
13 Havering [l 2 Training Locations

Ltih diat —-—

20.Slicers

1. Click on the
Insert tab

2. Click on 4

AutoSave B Y-

File Home Insert = oy View Hel .
— "1 Slicer
o= =] - - = i
0 ) E] "_é H—_'iGet Add-ins |:|:|? ED] EB E e
d . P(x v [I]]] ~ ﬁf‘h v 8 Column 7 Timeline
PivotTable Recommended llustrations (j i E Recommended a . Maps PivotChart 3D
PivotTables ¥ Ry AR < Charts ED v l‘_ e v v Map v 158 win/Loss
Tables Add-ins Charts Nl Tours Sparklines Filters
A B C E G H | L
1 LELT B prison B pate of birth [l Date registered [B@l Instrument experience [l Total hours [l Points per hour |
2 Wolfgang Puck HMP Pentonville 11/10/1982 20/01/2002 Bass 1 1
3 Julie Walters HMP Bronzefield 20/09/1973 08/02/2012 Bass, guitar 9 2
4 Margaret Atwood HMP Bronzefield 18/09/1963 07/06/2015 Drums 8 2
5 Usain Bolt HMP Manchester 21/07/1994 05/05/2014 Drums 24 3
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File Home Insert Page Layout Formulas Data Review View Help T4

Al - Je Name
A B C E G|

1 ame M Date of L M Date registered &4 ent e
2 'Wolfg|] 3-Select the field you ille 11/10/1982 20/01/2002 Bass
3 Juliev] Wwantto use as afilter eld . is, guitar
4 Margaret Atwoo ield Insert Slicers ? X ms
5 |Usain Bolt HMP Manc ams
6 |Alain Prost HMP Manchester DNa_me tar
7 Andre Agassi HMP Swansea efPrison - tar
8 Harper Lee HMP Bronzefield Sza;enogjlnh tar
9 Hone Heke HMP Pentonville DDZE registered tar
10 |Jason Robinson HMP Swansea [ Jage at registration tar
11 |Lionel Ritchie HMP Bristol [ Jinstrument experience tar
12 |Lorna Williamson HMP Holloway [Jrotal hours tar
13 |Serena Williams HMP Holloway [JPoints per hour tar
14 |John Steinbeck HMP Pentonville [Jrotal points tar, bass

Formatting a Slicer

When using a slicer it is a good idea to only include only filters for where data exists otherwise the filter will

return no results.

Insert  Pagelayout Formulas Data Review View Help  Options @ Tell me what you want to do
a
gelon A 4 g General = Normal Bad Good e
B s E
paste - COPY — A . 5 [checkcen | Hyperlink nsert D
Clipboard & Font Alignment Number Styles
Status - F 3
A | B | ¢ | b | E G H J K L M N o 3 Q R s T u v w x
Who's coming to our Data Essentials sessions?
1 .
2 . . =
31 Superhighways reach accross New to Superhighways? Knowledge Level before the Coutofiustomer D Borough =
4 London boroughs course Total ~
5 | Brent
6 Unknown
7 = Afle ErEnlsy
al Knowiedge Word of Mouth
97 88ry = Good knowledge e Email
1:’, o = Noknowiedge Nevsletter I
3 i i P ————0
— . Status =
e 1 Right click on Slicer o w om0 e
i . and select the option Slicer Sleer setings 1%
| ncel
19 - . Source Name: Status
Settings. Then tick the box
21| 20 Neme: |status Attending ~
| H H H Header
2 Hide items with no data. o——o—9

= —

Display header

24 mCroydon

25
26
27
28
29
30
31

|l el
5

|
w

J misington
mlsmbeth
Southwark
mTower Hamlets

3

Item Sorting aNE

@) Ascending (AtoZ)
() Descending [Z to A)

Use Custom Lists when sorting

ide items with no datal
Visually indicate items with no data
Show jtems with no data last
Show items deleted from the data source

Cancel




Linking the slicer to your charts

AutoSave B9~

Attendee data completed- Creating a Dashboard £ - Saving... v

superhighways
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File Home Insert Page layout Formulas Data Review View Help  Slicer
Slicer Caption: E@ 'E‘ 8 ‘ D '__\ ’—l BE- Ith [Mcotumns: 1 o Height [12.66 -
Borough Rle@'rt e =l L Ch = @ — {1 Height: 065em 7 s PN
n roup tate
[ slicer settings Conn::)tlom Elwidth: 281em - | | ea Widtt 387 em
Slicer Slicer Styles 1. select the Buttons size [
Report Con jons .
Borough -
Manage which ables the s“cer
A A slicer is connecte | F N L | M | N | (o] | P
3 v, .
| agtaw taE tials C
3| ldatawise dta £ssentials Lourse T
4 Py o SRR =
A e isati
5 i Westminster Attenda nce Type of Organisation Barnet 2
6 Wandsworth
9 Sutton .
10 southwark In the Slicer tab 27
11 Richmond . . - 2 City of Lon...
12 Not Applcable ribbon, click on ! o
13 Newham . . Frontline Infrastructure Public k l roydoen I
14 Wierton Report Connections in Ealing
15 Lewisham .
ol Lombeth the Slicer Tab Enfield
18 islington [N 7 =
2(1 Highbury and Islington [ 2 = Tower Hamlets
21 Havering [HIl 2 39% 1 m Southwark o
2 gy
< . 61% m Lambeth =
23 Hammersmith & Fulham [l 2 (] 20 ) Highbury a...
24 | Hackney [ S ulslington
25 eorid I + .  Groydon
26 Ealing [ 1 Islington
27 | Groydon I 11 _
28 Gy of tondon. I 1 .
29 | Camden [N 5 ¢ 0 5
30| sromiey [ 5
31 prent N ©
22 Barnet [N 3

26
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Refreshing the Dashboard

Yy

AutoSave Attendee data completed- Creating a Dashbo... &* - Saving...

File Home Insert Page Layout Formulas Data Review View Help PivotChart Analyze Design Format

ﬁ [LE From Text/CSV I:(hg Recent Sources |j|§ m Queries & Connections A

z
[a From Web [E Existing Connections . Properties - 4
z| Sort ilter
Data « Bfrom Table/Range AII B |2, Edit Links :"i
< _(jet & Transform Data d r% Refresh Al Refresh All (Ctrl+Alt+F5) Sort & Filter Data T¢
~datawise W}

3 %, LoWoON & Refresh Get the latest data by refreshing all

4 7, > nefres i

* | III'“\\ sources in the workbook. B

5 | westminster [ 3 - [ype of Organisation oroy

‘Wandsworth - 2 10 Ealin
Waltham Forest 2

0| Tower Hamlets Enfie
7 Sutton Hack
o | Southwark

8 ! o s Ham
9 Richmond | R f h A"
10 Not Appiicable [N 3 Select Refres Harr
11 Newham [ 3 on the Data tab Have
12* Merton - 2 Frontline Infrastructur¢ | High
= tewishar NN =
14 tamber N © Hour
15 kingston [l 2 ) o o Isling
:11% R New to Superhighways? King
1§ Hounslow . 1
15 Highbury and Islington - 2 Lamb
26 Havering - 2 Lewi

— W Tower Hamlets
121 Harrow . 1 Mert
2? Hammersmith & Fulham - 2 = Southwark
23_ Hackney _ 5 M Lambeth Newl
24_ Enfield - 4 M Islington Not £
1 o -

L S L o a i T i T
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